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CHAPTER 1 EDITING MESSAGES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 learn how to copy and paste within a message 

 learn how to copy content between email messages 

 learn how to copy information from another source 
document into a message 

 learn how to delete text from a message 

 learn how to remove an attachment before forwarding a 
message. 

Most email messages are comprised of text. This is because email 
messages are used predominantly by people to communicate with 
each other. Many of the techniques that are used for working with 
text in word processing applications also apply to email messages 
in Outlook. 
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COPYING TEXT WITHIN A MESSAGE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Most email applications have word processing 
features that conform to standard Windows 
conventions. In this respect, Microsoft Outlook is 
no exception. To help perform basic operations 

such as cutting, copying and pasting, Outlook 
provides a set of tools on the Compose Tools: 
Message tab and the various other contextual tabs 
available on the ribbon. 

Try This Yourself: 
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 Before starting this exercise you 

MUST open the file 
Outlook_13.pst... 

 
Ensure Mail is selected in the 
Navigation bar and that the 
Outlook_13 file is expanded in 
the Folder pane  

 
Select Inbox in the Folder 
pane, then ensure the message 
from Fritz Winters with the 
Fleet Management Expenses 
subject is selected in the 
message list 

 
Click on Forward at the top of 
the Reading pane to display a 
new message  

 
Address the message to either 
yourself or one of your 
colleagues  

 
Select the table 

 
On the Compose Tools: 
Message tab, click on Copy in 
the Clipboard group to copy the 
table to the clipboard 

 
Click in the top part of the email 
where you want to type your 
message, then click on the top 
half of Paste in the Clipboard 
group to paste the table into the 
message 

 
Click on Discard at the top of 
the Reading pane to discard the 
message 
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For Your Reference… 

To copy text within a message: 

1. Select the text to copy, then click on the 
Compose Tools: Message tab 

2. Click on Copy in the Clipboard group 

3. Position the insertion point where you want 
the text inserted, then click on the top half of 
Paste in the Clipboard group 

Handy to Know… 

 You can use the standard Windows 
keyboard shortcuts for copying and pasting 
information in an email message. For 
example,  +  will copy a selection to 

the clipboard and  +  will paste it. 
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COPYING TEXT BETWEEN MESSAGES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Occasionally, you may find that you want to 
compose an email message that is very similar to 
a message you have previously created or 
received. As long as you haven’t deleted the 

required email or the folder that contains it, you can 
simply open the email, select and copy the desired 
information and paste it into the new message. 

Try This Yourself: 
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 Continue using the 

previous file with this 
exercise... 

 
In the message list, double-
click on the message from 
Fritz Winters with the 
Fleet Management 
Expenses subject to open 
it in a new window 

 
On the Message tab, click 
on Actions in the Move 
group, then select Edit 
Message 

 
Select the table 

 
Click on the Format Text 
tab, click on Copy in the 
Clipboard group, then 
close the message window 

 
Click on New Email in the 
New Items group to 
display a new untitled 
message in a new window 

 
Click in the body of the 
message, then on the 
Message tab click on the 
top half of Paste in the 
Clipboard group to paste 
the table into the message 

 
Press , then click on 

[Yes] to close the message 
and save it in the Drafts 
folder 
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For Your Reference… 

To copy text between messages: 

1. Open a message, click on the Message tab, 
click on Actions in the Move group, then 
select Edit Message 

2. Select the text, click on Copy in the 
Clipboard group then close the message 

3. Open a new message, click on Paste  

Handy to Know… 

 To move text either within a message or to 
another message, click on Cut in the 
Clipboard group, position the cursor where 
you want the text inserted, then click on the 
top half of Paste. 

 The keyboard shortcut for Cut is  + . 
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COPYING FROM ANOTHER SOURCE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you have an existing document that contains 
information you would like to replicate in a 
message that you’re composing, you don’t need 
to retype it. You can open the document in the 

application that was used to create it and then 
employ the standard Windows techniques to copy 
the desired data or text and paste it into the email 
message. 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise and open the 
file Parking_1.docx... 

 
Navigate to page 3 of 
the Word document, 
then click on the Car 
Parking Spaces chart 
to select it 

 
Ensure that the Home 
tab is active, then click 
on Copy in the 
Clipboard group to 
copy the chart to the 
clipboard 

 
Close Microsoft Word 

If necessary, click on 
[Yes] to keep the 
information on the 
clipboard…  

 
Return to Outlook and 
create a new message 

 
Click in the text area of 
the message, then on 
the Message tab, click 
on the top half of Paste 
in the Clipboard group 
to paste the chart into 
the message 

 
Press  and click on 

[Yes] to close the 
message and save it in 
the Drafts folder 
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For Your Reference… 

To copy data from another source: 

1. Open the application with the data 

2. Click on Copy  

3. Open the mail message 

4. Position the cursor, then click on the top half 
of Paste in the Clipboard group 

Handy to Know… 

 You may need to reformat data pasted into 
an email message that you have copied from 
another application. 
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DELETING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Outlook employs most of the functionality that 
you find for working with text in a word 
processing application. You can therefore type, 
copy, move, and also delete text if it’s no longer 

required. The same techniques for deleting text in a 
word processing program can be used in an 
Outlook email message. 

Try This Yourself: 
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 Continue using the 

previous file with this 
exercise... 

 
In the message list 
double-click on the email 
from Fritz Winters with 
the Fleet Management 
Expenses subject  

 
Click on Forward in the 
Respond group and 
address the message to 
either yourself or one of 
your colleagues 

 
Select the text that 
appears before the table, 
as shown 

 
Press  to delete the 

selected text 

 
Type Here are the 
figures 

 
Press , then click on 

[Yes] to close the 
message and save it in 
the Drafts folder 

 

For Your Reference… 

To delete text in a message: 

1. Select the desired text 

2. Press  

3 

Handy to Know… 

 If you accidentally delete the wrong text, click 
on Undo in the Quick Access Toolbar to 
reverse the deletion. 
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REMOVING AN ATTACHMENT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you receive a message with one or more 
attachments and then forward it to someone else, 
the attachments will be included in the forwarded 
message by default. If the attachments are not 

relevant to the people to whom you are forwarding 
the message, you can remove them from the 
message before forwarding it. 

Try This Yourself: 
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 Continue using the 

previous file with this 
exercise... 

 
In the message list, 
double click on the 
message from Amanda 
Bennett with the Parking 
subject 

 
Click on Forward in the 
Respond group, then 
address the message to 
either yourself or one of 
your colleagues 

 
Right-click on the Parking 
Diagram.jpg attachment 
in the message header 
and select Remove 
Attachment as shown 

The attachment file will 
disappear from the 
Attached box... 

 
Select all of the text in the 
message, press , then 

type Can you please 
review the attached 
parking survey? 

 
Press , then click on 

[Yes] to close the 
message and save it in 
the Drafts folder 
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For Your Reference… 

To remove an attachment from a message: 

1. Open the message with the attachment 

2. Right-click on the attachment 

3. Select Remove 

Handy to Know… 

 You can remove an attachment from an open 
message by highlighting the attachment file’s 
name and pressing . 

 You can view options for what to do with an 
attachment by right-clikcing on the 
attachment and selecting an option. 
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CHAPTER 2 ORGANISING MESSAGES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 learn how to create a mail folder 

 learn how to move messages into other mail folders 

 learn how to copy messages between folders 

 learn how to delete messages 

 learn how to recover messages from the Deleted Items 
folder 

 learn how to clean up conversations 

 learn how to work with the Favourites folder list 

 learn how to delete message folders 

 learn how to recover deleted folders 

 learn how to empty the Deleted Items folder 

 gain an understanding of quick steps 

 learn how to customise default quick steps 

 learn how to create a new quick step 

 learn how to use quick steps 

 learn how to archive messages 

 learn how to recover archived messages. 

Outlook provides a number of tools and features for organising your 
email messages. For example, you can delete messages and move 
and copy messages to your own custom mail folders. You can also 
use quick styles to perform multiple step functions on your 
messages with a single click, plus more. 

INFOCUS 

Sam
ple



Microsoft Outlook 2016 - Level 2 

© Watsonia Publishing Page 8 Chapter 2 - Organising Messages 

CREATING A MESSAGE FOLDER 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A message folder is a repository for mail 
messages. There are a number of standard 
message folders in the mailbox including the 
Inbox, Outbox, Sent Items, Deleted Items, and 

so on. You can create additional message folders 
to store your messages. For example, if you are 
involved in several projects, you could create a 
folder for each project to store messages. 

Try This Yourself: 
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Before starting this 
exercise you MUST 
open the file 
Outlook_14.pst... 

 
In the Folder pane, 
ensure the outlook data 
file is expanded, then 
click on Inbox under 
outlook data file 

Let’s create two new 
folders for the Amazon 
and Thames projects… 

 
Click on the Folder tab 
to see the commands 
you can use with 
Outlook folders 

 
Click on New Folder in 
the New group to open 
the Create New Folder 
dialog box 

 
Type Thames in 
Name, then ensure 
that Inbox is selected 
under Outlook Data 
File in Select where to 
place the folder 

 
Click on [OK] to add 
the new folder under 
Inbox 

 
Repeat steps 2 to 5 to 
create a new folder 
called Amazon in the 
Inbox 

 

2 
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For Your Reference… 

To create a new message folder: 

1. Click on the Folder tab, then click on New 
Folder in the New group  

2. Type the name of the new folder and choose 
where to place the folder 

3. Click on [OK] 

Handy to Know… 

 You can also create a new mail folder by  
right-clicking on an existing folder in the 

Folder pane and selecting New Folder. 

6 
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MOVING MESSAGES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Outlook lets you easily move messages between 
folders  – such as new folders that you have 
created or existing ones. There are several ways 
to move messages from one folder to another. 

Here we will show you how to use the Move 
command on the ribbon as it allows you to move 
messages easily into folders anywhere in your 
Outlook system. 

Try This Yourself: 
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 Continue using the 

previous file with this 
exercise... 

 
Ensure that 
conversations is 
enabled, then click on the 
Home tab 

You can enable 
conversations by clicking 
on the View tab and 
selecting Show as 
Conversations in the 
Messages group… 

 
Under outlook data file, 
click on Inbox, then click 
on the Thames 
conversation 

This is the email from 
Declan O’Shannasy with 
the Subject: Thames… 

 
Click on Move in the 
Move group, as shown, to 
display a list of folders 
that you have visited 
recently 

Your list may be different 
to the one shown… 

 
Click on Thames – 
outlook data file to move 
the message to this folder 

 
Click on Thames in the 
Folder pane to see the 
message in this folder 
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For Your Reference… 

To move messages: 

1. Select the messages to move 

2. Click on the Home tab, then click on Move in 
the Move group  

3. Click on the desired folder 

Handy to Know… 

 You can drag messages between folders in 
the message list and from a folder to a folder 
icon in the Folder pane. 

 You can drag and drop folders to new 
locations in the same way that you can drag 
and drop mail messages. Any items within a 
moved folder will move with the folder. 
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COPYING MESSAGES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you want to place a copy of a message in more 
than one location, Outlook allows you to copy 
messages between folders. And just like many 
other functions, there is more than one way in 

which you can perform this feat. You can use the 
ribbon, drag and drop, or the keyboard shortcut 
combination −  +  and  + . 

Try This Yourself: 

S
a
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 Continue using the 

previous file with this 
exercise... 

 
Under outlook data 
file click on Inbox, 
then click on the 
Introducing the new 
phase conversation 

 
On the Home tab, click 
on Move in the Move 
group, then select 
Copy to Folder to 
open the Copy Items 
dialog box 

 
Ensure that Thames is 
selected under Inbox, 
then click on [OK] 

Because this is a 
conversation, a 
message may 
display… 

 
Click on [OK] to copy 
the conversation to the 
folder 

 
Click on Thames in the 
Folder pane to see the 
messages in the 
message list 
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For Your Reference… 

To copy messages: 

1. Select the messages 

2. Click on Move in the Move group, then 
select Copy to Folder 

3. Click on the name of the destination folder, 
then click on [OK] 

2 3 

Handy to Know… 

 You can copy messages between folders 
using the drag and drop method. To do this, 
select the messages to be copied in the 
message list, and then press  while you 

drag them to a new folder in the Folder 
pane. 
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DELETING MESSAGES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

It is good housekeeping practice to purge your 
folders of unwanted messages. You can do this 
by deleting them. Deleting messages works a 
little like the Recycle Bin in Windows – when you 

delete a message, or in fact anything in Outlook, 
the deleted item is moved into a special Deleted 
Items folder rather than being actually deleted. 

Try This Yourself: 

S
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F
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 Continue using the 

previous file with this 
exercise... 

 
Under outlook data 
file click on Inbox, 
then click on the 
Attaching Items 
message in the 
message list 

 
On the Home tab, 
click on Delete in the 
Delete group 

The message will be 
deleted from the 
Inbox... 

 
In the Folder pane 
under Outlook_14, 
click on Deleted 
Items to see the 
deleted message 
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For Your Reference… 

To delete a message: 

1. Select the messages you wish to delete in 
the message list 

2. Click on the Home tab, then click on Delete 
in the Delete group 

Handy to Know… 

 If you delete items from the Deleted Items 
folder, they will be permanently removed 
from Outlook. 

 You can permanently delete a selected 
message from any folder by pressing  + 

. A message asking you to confirm your 

intention will appear. 

2 
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RECOVERING DELETED MESSAGES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you delete a message from all folders 
except Deleted Items, they will be automatically 
removed from the folder and added to the 
Deleted Items folder. If you change your mind or 

if you realise that you deleted the wrong message, 
you can recover a message from Deleted Items 
and move it back to the original folder. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the 

previous file with this 
exercise... 

 
In the Folder pane ensure 
Deleted Items is 
selected, then click on the 
Attaching Items 
message in the message 
list to select it 

Let’s return this message 
to the Inbox... 

 
Right-click on the 
Attaching Items 
message and point to 
Move then select Inbox – 
outlook data file 

If Inbox – outlook data file 
isn’t listed, click on Other 
Folder, select Inbox under 
outlook data file and click 
on [OK]. 

The message will 
disappear from the 
Deleted Items folder... 

 
In the Folder pane, click 
on Inbox to ensure the 
message has reappeared 
again in the message list 
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For Your Reference… 

To recover deleted messages: 

1. Click on Deleted Items in the Folder pane 

2. Select the required messages in the 
message list 

3. Right-click on a selected message and 
select Move > folder name 

Handy to Know… 

 You can delete or recover multiple messages 
simultaneously. To do this, click on the first 
message, then press  and click on the 

desired messages. Press  to delete them 

or right-click on them and select Move > 
folder name to recover deleted messages. 
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